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Documentation updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.
l Document Release Date, which changes each time the document is updated.
l Software Release Date, which indicates the release date of this version of the software.

To verify you are using the most recent edition of a document, go to
https://softwaresupport.softwaregrp.com/group/softwaresupport/search-result?doctype=manuals?keyword=.

To check for recent software patches, go to
https://softwaresupport.softwaregrp.com/group/softwaresupport/search-result?doctype=patches?keyword=.

This site requires that you register for a Passport and sign in. To register for a Passport ID, go to
https://cf.passport.softwaregrp.com/hppcf/login.do.

Or click the Register link at the top of the Software Support page.

You will also receive updated or new editions if you subscribe to the appropriate product support service.
Contact your sales representative for details.

The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.
l Document Release Date, which changes each time the document is updated.
l Software Release Date, which indicates the release date of this version of the software.

To verify you are using the most recent edition of a document, go to
https://softwaresupport.softwaregrp.com/group/softwaresupport/search-result?doctype=online help.

This site requires that you register for a Passport and sign in. To register for a Passport ID, go to
https://cf.passport.softwaregrp.com/hppcf/login.do.

You will also receive updated or new editions if you subscribe to the appropriate product support service.
Contact your sales representative for details.

For information and details about the products, services, and support that offers, contact your Client Director.
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Support
Visit the Software Support Online web site at https://softwaresupport.softwaregrp.com/.

This web site provides contact information and details about the products, services, and support that offers.

online support provides customer self-solve capabilities. It provides a fast and efficient way to access
interactive technical support tools needed to manage your business. As a valued support customer, you can
benefit by using the support web site to:

l Search for knowledge documents of interest
l Submit and track support cases and enhancement requests
l Manage software licenses
l Download new versions of software or software patches
l Access product documentation
l Manage support contracts
l Look up support contacts
l Review information about available services
l Enter into discussions with other software customers
l Research and register for software training

Most of the support areas require you to register as a Passport user and sign in. Many also require a support
contract.

To register for a Passport ID, go to https://cf.passport.softwaregrp.com/hppcf/login.do.

Visit the Software Support Online web site at https://softwaresupport.softwaregrp.com/.

This web site provides contact information and details about the products, services, and support that offers.

online support provides customer self-solve capabilities. It provides a fast and efficient way to access
interactive technical support tools needed to manage your business. As a valued support customer, you can
benefit by using the support web site to:

l Search for knowledge documents of interest
l Submit and track support cases and enhancement requests
l Manage software licenses
l Download software
l Access product documentation
l Manage support contracts
l Look up support contacts
l Review information about available services
l Enter into discussions with other software customers
l Research and register for software training

Most of the support areas require you to register as a Passport user and sign in. Many also require a support
contract.

To register for a Passport ID, go to https://softwaresupport.softwaregrp.com/.

To check for recent updates or to verify that you are using the most recent edition of a document, contact
your Client Director.
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Application Performance Management
Release Notes
This document provides information about Application PerformanceManagement (APM) 9.50.

What's New in This Release
APM 9.50 includes new functionality, customer escalation fixes, and internal bug fixes. To view a full
list of new features and enhancements in APM 9.50, select Help > What’s New in APM, or download
theWhat's New document from the Software Support site.

APMSupport Matrixes
APM system requirements and support matrix information, including APM server and database support
matrixes as well as support and compatibility data for APM data collectors and other APM
components, is now located in the separate APM System Requirements and Support Matrix document,
located on the Software Support site.

Information about supported integrations between APM and other third-party software is now available
on the Software Solution and Integration Portal (requires Passport login). Every integration listed
includes a description of the integration, support matrix, and links to integration configuration
documentation.
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Installation Instructions
Before installing APM 9.50, review the system requirements in the APM System Requirements and
Support Matrixes Guide (https://softwaresupport.softwaregrp.com/km/KM03161763).

For complete instructions on installing this software, see the relevant documentation:

Current
BSM/APM
version

Notes See instructions in:

New
customers

- APM 9.50 Installation Guide.

https://softwaresupport.softwaregrp.com/km/KM03161780

Existing
customers
upgrading
from APM
9.4x

- APM 9.50 Upgrade Guide

https://softwaresupport.softwaregrp.com/km/KM03161709

Existing
customers
upgrading
from BSM
version 9.25
or 9.26

Youmust upgrade
your existing BSM
to APM 9.30 with
the latest patch and
then upgrade to
APM 9.50.

If you are using the
staging upgrade
option (from BSM
9.25/6) with the
standalone SDR,
you need to use the
9.30 SDR. You can
also use the 9.30
SDR to send the
samples from BSM
9.25/6 to the
staging APM 9.30.

When you will

1. APM UpgradeGuide - BSM 9.25 or 9.26 to APM 9.30

https://softwaresupport.softwaregrp.com/km/KM0222546
9

2. APM 9.50 UpgradeGuide

https://softwaresupport.softwaregrp.com/km/KM0316170
9
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Current
BSM/APM
version

Notes See instructions in:

upgrade the staging
APM 9.30 directly
to APM 9.40, you
can use the same
9.30 SDR to send
samples to APM
9.50.

Themost updated versions of these documents are available from the Software Support site.

NOTE:
If you are upgrading to APM 9.50 and are running Red Hat Enterprise Linux 5.x, upgrade your
operating system to Red Hat Enterprise Linux 6.x or 7.x and then perform the upgrade using the
Direct upgrademethod.

APM 9.50 Planning Guides Package, which contains:

l Getting Started Guide

l Deployment and Capacity Planner (Capacity Calculator)

l System Requirements and Support Matrixes Guide

l DatabaseGuide

l What's New document

APM 9.50 Deployment Guides Package, which contains:

l Release Notes

l DatabaseGuide

l Installation Guide

l APMUpgradeGuide

l Smart Card Authentication Configuration Guide

l Hardening Guide

Release Notes
Installation Instructions

Application Performance
Management (9.50)

Page 9 of 45

https://softwaresupport.softwaregrp.com/
https://softwaresupport.softwaregrp.com/km/KM03161849
https://softwaresupport.softwaregrp.com/km/KM03161852


Updated Components
The following updated components have been released in parallel to APM 9.50 with new features
and/or bug fixes. For more information about the features and fixes included in each component, see
the documentation included with the component. The APMWhat's New document also lists key new
features for updated components.

Components must be downloaded separately from either the software updates (major/minor releases,
e.g., 9.00 or 9.20) or from software patches (patch releases, e.g., 9.13, 9.23). Both software updates
and software patches can be accessed from the Software Support site
(https://softwaresupport.softwaregrp.com/).

l Real User Monitor 9.50

For instructions on installing Real User Monitor (RUM), see the Real User Monitor Installation and
UpgradeGuide, accessible with RUM or from the Software Support site.

l Business Process Monitor 9.50

For installation instructions, see the Business Process Monitor Deployment Guide, available with
BPM or from the Software Support site.

l SiteScope 2018.05

For installation instructions, see the SiteScope Deployment Guide, available with SiteScope or from
the Software Support site.

l Data Flow Probe 11.0

For installation instructions, see the Data Flow Probe for APM 9.50 Installation Guide, also available
from the Software Support web site.

NOTE:
APM 9.50 will only work with the version of the Data Flow Probe associated with the 9.50
release. Make sure to download and install the correct Probe from the Software Patches
page. The Data Flow Probe 11.0 setup file is titledHPEAPM9.50_DataFlowProbe _
11.0.exe.

l System Health for APM 9.50

For installation instructions, see the System Health User Guide, available with System Health or
from the Software Support site.

NOTE:
System Health for APM 9.50 will only work with APM 9.50. It will not work with any earlier
versions of APM.
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l Diagnostics 9.50

For installation instructions, see the following guides, available with Diagnostics or from the
Software Support site:

Diagnostics Server Installation and Administration Guide

Diagnostics Collector Installation Guide

Diagnostics Java Agent Guide

Diagnostics .NET Agent Guide
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Fixed Customer Encountered Defects
The following is a list of fixed customer encountered defects. They are listed according to product and
version and are identified by a Change Request number (QCCRxxxxxxxx). Use this number when
looking for more information about the problem on the Software Support web site
(https://softwaresupport.softwaregrp.com/), or when communicating with your Support representative.

Fixed in APM 9.50
Global ID Summary

QCCR1I123006 Application Health - Users with System Viewer permissions have access to the
Settings tab

QCCR1I126974 RTSM: OOTB Integration Point RTSM to RTSM could not authenticate on remote
target

QCCR1I127265 Login for internal user to BSM takes 2-4minutes

QCCR1I127481 Problem getting data from database

QCCR1I127596 System Health Documentation andWizard Does Not Explain User Permissions
for OBM andDatabase

QCCR1I128009 Configserver stops at RTSM schema step with " The specified schema is not
valid!"

QCCR1I128017 Deployment Guide refers to older version installation paths

QCCR1I128254 The documentation displays an incorrect default value for the infrastructure
setting scheduled report 'email sender'

QCCR1I128435 Editing Open New Window Url - Infrastructure Setting - shows XSS Error Page.

QCCR1I128640 DTT - SQL Error - usernamewas not specified Kerberos (Type 4) ERROR
message

QCCR1I129135 Geographic Map not working

QCCR1I129468 Location Summary Geographical Map is still not shown

QCCR1I129516 After Disabling TLSv1 in APM unable to load End User Management
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Global ID Summary

QCCR1I129710 Datamarking tool does not work

QCCR1I130722 Standalone SDR basic authentication tool - Update basicauth command line

QCCR1I130735 Top View not updating with actual status

Fixed in BPM 9.50
Issue ID Summary

130187 Columns under bpm perf over time showing funny values

130526 ORACLE Scripts fails on BPM

Fixed in RUM 9.50
Issue ID Summary

127372 Issues adding Engines to Application Tiers

127524 MySQLUpgrade - failed to retrieve disk space when partition is on E:\

127619 Unable to extract parameters from requests only

127713 Instrumentation giving error while instrumenting the application

127714 Urgent - Application functionality crashing Post RUM instrumentation

127717 Throttling Net Perform Results Affected by HP RUM

128316 Instrument new variant of the shouldOverrideUrlLoadingmethod - boolean
shouldOverrideUrlLoading (WebView view, WebResourceRequest request)

128325 Session Identification field with colon is not supported

128598 Can not update configuration for RUM application with 360 license

128705 Unable to configure HTTP status codes below 400 as an error Event

128892 Installation - decryption of SSL tarnsactions with extendedmaster secret

128945 Android instrumentation for hybrid application breaks application's workflow on
Android Oreo devices
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Issue ID Summary

128972 rum probe can not catch network data

129086 Update RUM 9.40 Upgrade and Troubleshooting section when the tool fails -
RUM 9.30 to 9.40 Upgrade: MySQL_v5.5_to_v5.7_upgrade_tool.bat fails

129275 Duplicate rows in RUM Session Summary Report

129518 Importing 9.26 template - URL not imported

129731 System Viewer Role User able to perform admin level functions on RUM Engine
Resources

130609 Error in APM Application health - RUM - Volume "There is currently a problem
retrieving data for the report"

Fixed in SIS 2018.05
Issue ID Summary

124354 Support for SQL server 2016

125753 Timeout for the Custom Databasemonitor is not working.

130508 REST API monitor gets n/a for all counters

130464 Nested volumes not parsed underWMI

128849 Stack Size setting for Sitescope is incorrect.

130545 Deployment Guide needs to be corrected for patch installation instructions

131026 Multi LogMonitor still searching old files

130618 Documentation Error Regarding FIPS 140-2 Compliancy

130378 SiteScope database logging not match as document said

128300 Sitescope ability to Monitor MS SQL2000 Doc change request
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Fixed in Diag 9.50
Issue
ID

Summary

126724 Security issue with Argument Injection or Modification in Diagnostics Commander

126725 Diagnostics Commander Insecure Direct Object Reference via URL address

126726 Diagnostics Commander shows unsecured File and Directory Information Exposure

128624 HP Diagnostics 9.26 Dotnet Agent 9.26 9.26.14.22448 overhead issue

129094 Applications and Application Group trees created using CAM randomly disappear and
reappear in the UI

129494 Installing Diagnostics in a user defined directory

Release Notes
Fixed Customer Encountered Defects

Application Performance
Management (9.50)

Page 15 of 45



Notes and Limitations
Problems and limitations are identified with a Change Request number (QCCRxxxxxxxx). Use this
number when looking for more information about the problem on the Software Support web site
(https://softwaresupport.softwaregrp.com/), or when communicating with your Support representative.

To see themost updated status of limitations listed in this section, new limitations published after
version release, or generally to view a list of known problems for a specific product and/or version, on
the Software Support web site sign in and click Search. Select the relevant product, version, and
operating system (for example, Application PerformanceManagement (BAC) > 9.40 > Windows), and
select Known Problems in theDocument types area. You can also search for a specific CR using
the search box at the top of the Self-Solve Knowledge Search page.

General and Deployment
Post Install cannot find the installed web site. IIS10 on Windows 2016 Standard/Datacenter
Edition (QCCR1I125841)

APM does not support Microsoft Internet Information Services (IIS) 10.

APM supports Windows Server 2016 Standard/Datacenter Edition (64 bit) with Apache HTTP Server,
however, there will be a slight degradation in performance during installation.

CAC: Java applets are not loaded in some cases (QCCR1I118356)

Description: Java applets are not loaded in some cases. The following error appears: Error signing
certificate verify.

Workaround: If this error occurs, use custommode instead of Full CAC mode for Smart Card
Authentication configuration (CAC)mode.

Customized version of httpd-ssl.conf file might be overwritten (QCCR1I41178)

Description: If APM is configured for secure access (using Apache + SSL), APM uses a customized
version of the file httpd-ssl.conf on theGateway Server. This file might be overwritten during the
upgrade with a standard version of the file, breaking the configuration.

Workaround:Before upgrading, backup the customized file <APM root
directory>\WebServer\conf\extra\httpd-ssl.conf. Then reapply the changes to httpd-
ssl.conf using the backup version as a reference to the location of the certificate files.

High Availability Controller cannot move services (QCCR1I46345)
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Description: If there is a problem with one of themarble_* processes (for example, one of the
processes cannot start), youmust disable themarble_supervisor process. If this process is not
disabled, the High Availability Controller (HAC) cannot move the process’ services (such as the
DASHBOARD service that controls Service Health) to another Data Processing Server if there is a
problem with the primary server.

Workaround: Disable themarble_supervisor process. HAC will move DASHBOARD service to
another DPS.

Restart of APM may be required after database outage (QCCR1I46504)

Description: If themanagement database was down or unreachable and the connection has been
restored, youmay have to restart APM.

Workaround: Restart APM when themanagement database is available again.

Adding additional Gateway servers with differing paths causes login failures (QCCR1I47337)

Description: If twoGateway servers are installed onto different drive paths, for example, one was
installed onto the C:\ drive and the other onto the E:\ drive, APMmay not be able to be accessed.

Workaround: Create a duplicate path on the C:\ drive by copying E:\<APM root
directory>\conf\settings to C:\<APM root directory>\conf\settings.

Upgrade will fail if IDM-SSO is enabled in the source environment (QCCR1I58648)

Description: If you are using IDM-SSO, upgrade will fail if IDM-SSO is enabled in the source
environment but not yet configured in the target environment.

Workaround: Disable IDM-SSO on the APMGateway Server before running the configuration
upgrade in the target environment. To do so:

1. Log into the JMX console (http://<Gateway Server name>:29000) and search for the SSO
service (service=SSO).

2. Locate the setSingleSignOnMode operation and in the ParamValue box, type Lightweight.

3. Click Invoke.

IDM-SSO can be re-enabled after APM is up and running from within APM (Admin > Users and
Permissions > Authentication Management wizard).

Platform
Authentication:When Application PerformanceManagement is installed with anOracle Database
and User Synchronization enabled with an LDAP Active Directory server, ensure that you login to
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Application PerformanceManagement with the correct-case UID (uppercase or lowercase), as
configured on the LDAP server. This is because while the Oracle Database is case-sensitive, the
LDAP Active Directory is not case sensitive, and logging in with an incorrect case UID can create
undesirable results.

For example, if a user called testuser exists on the LDAP Active Directory server and logs into
Application PerformanceManagement , he is automatically created as Application Performance
Management user testuser, who can be assigned permissions in the Application Performance
Management User Management interface. If you then login to Application PerformanceManagement
as Testuser, the LDAP Active Directory server sends an acknowledgement that the user exists
(because Active Directory is not case sensitive) and he is allowed entry to Application Performance
Management . However, since the Oracle Database does not identify this user as testuser (because
the Oracle Database is case sensitive), the user Testuser is treated as a new user, without the
permissions that were assigned to testuser.

NLS_LENGTH_SEMANTICS: The recommended setting for Oracle parameter NLS_LENGTH_
SEMANTICS is the default setting of BYTE; setting this value to CHAR may affect database
performance.

Infrastructure Settings: Changes to infrastructure settings are not included in the Audit Log.

Schema Creation: You cannot create a schema that starts with a digit.

Downtime notifications may not be sent if the Data Processing Server is down (QCCR1I44964)

Description: If the Data Processing Server is down for any reason, notifications of downtime starting
and ending during the time period when the Data Processing Server was downmay not ever be sent.
Notifications sent to recipients regarding downtimes are configured during downtime creation.

Workaround: None.

Java applets may fail to load (QCCR1I57396)

Description: Java applets may fail to load intermittently.

Workaround: If a Java applet in APM fails to load, clear your Java client cache:

1. In theWindows Control Panel, click Java.

2. On theGeneral tab, select Settings > Delete Files.

Applets fail to load when  "Internet Explorer Enhanced Security" is enabled (QCCR1I59140)

Description: In some environments, certain applets fail to load when Internet Explorer Enhanced
Security is enabled on the client machine (for example, the LDAP Group Mapping Wizard).
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Workaround: Disable Internet Explorer Enhanced Security on the client machine (for example,
Control Panel > Add/Remove Programs > Add/Remove Windows Components > scroll down to
Internet Explorer Enhanced Security Configuration and uncheck the box).

Login page does not load if accessing through LB in separate domain from APM
(QCCR1I60724)

Description: When connecting to APM using an FQDN, you still see the following error in the login
screen: The Application PerformanceManagement URLmust include the Fully Qualified Domain
Name (FQDN).

Workaround:Retype the Application PerformanceManagement URL in the address bar, and check if
there is a DNS resolution for Load Balanced virtual IPs from the APM gateways.

MIB validation program returns multiple issues (QCCR1I78961)

Description: MIB validation program returns multiple issues.

Workaround:None.

Personalization for Downtime Management (QCCR1I91787)

Description:Users who are assigned Full Control permission on the Downtime resource canmodify
all CI Downtimes (even CI Downtimes created by another user with Full Control permission on
Downtimes). The problem is that users should NOT be able to disable or modify downtimes that they
did not create.

Workaround:None.

User names in multiple LDAPs must be unique (QCCR1I102048)

Description:Users created on different LDAPs with the same user name unite to a single user.
Therefore, user names inmultiple LDAPs must be unique.

Workaround:None.

Standalone Staging Data Replicator fails to connect to Production APM server in Windows
and Linux(QCCR1I131108)

Description:Standalone SDR does not start properly since the connection failed with the production
server HornetQ. Therefore, it failed to get samples from production APM server.

Workaround:Use embedded Staging Data Replicator

Integrations
EMS Integration:
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l Themaximum size of an expression in the EMS Integration configuration file is 4000 characters.

l An EMS monitor may not find its configuration file when upgrading the SiteScope version. In such
cases, manually copy the contents of the configuration file to the EMS monitor configuration in the
user interface.

In the APM-Diagnostics integration (Admin>Diagnostics) an error occurs on short-name and
there is no way to re-enter the FQDN (QCCR1I62229)

Description:You should use the FQDN when registering the Diagnostics Server with APM . However
if you entered a non-FQDN for the Diagnostics Server you could get stuck in a registration problem
loop.

Workaround:Use the URL below and substitute the “topazhost” name in the URLwith the FQDN of
the APM Gateway Server to clear the Diagnostics Configuration page in APM:

http://topazhost/opal/uibridge/action/registration.do?action=set_
registration&customer_name=Default%20Client&opal_protocol=&opal_port=&opal_full_
host=

Diagnostics > APM 9.30 limitation due to Operations Bridge Manager (OBM ex OMi) removal.
(QCCR1I118157)

In previous releases of BSM, Diagnostics sent CIs, metrics, and events to BSM. Health Indicator
status (coloring) for the Application Infrastructure CIs was based on events sent to BSM through the
OBM event channel.

In APM 9.30, due to the OBM removal, Diagnostics sends events to OBM and continues to send CIs
andmetrics to APM. As a result of this change, the Application Infrastructure CIs (Diagnostic Probe,
Oracle/MSSql Database, IBMWebSphereMQ, WebSphere AS Dynamic Caching, IBMWebSphere
MQ, IBMMQ, WebLogic AS. JBOSS AS, SQL Server, MSSQLDatabase, Oracle iAS, Oracle, SAP,
SAP R3 Server, VMware ESX Server, Host Node) do not show the correct HI Status in APM 9.30.

The HI status for these CIs appears as Undetermined (blue questionmark). If you are upgrading from
BSM 9.2x to APM 9.30, the last status received for the CI before the upgrade will be displayed.

Workaround: To enable sending events related to threshold violation in Diagnostics to OBM, in the
server\bin directory of the Diagnostics server :

1. Run cscript switch_ovo_agent.vbs -server <FQDN of OBM> -cert_srv <FQDN of OBM>.

2. Go toOBM Administration > Certificate Requests and grant certificates.

3. Run cscript switch_ovo_agent.vbs -server <FQDN of OBM> -cert_srv <FQDN of OBM>
again. All tasks should now display correctly.

SiteScope re-direct to HTTPS APM 9.30 does not work. (QCCR1I118851)
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When redirecting SiteScope from BSM 9.26 to APM 9.30 using the staging upgrade, the following error
appears:

“Failed to re-register to Application PerformanceManagement: Calling to BAC API failed.”

Workaround:

1. Go toAPM 9.30 > Administration > System Availability Management.

2. In the Summary pane, select the SiteScope integration and click . The integration will

automatically be deleted from the SiteScope side.

3. Click to create the integration again.

Operations Orchestration (OO) REST Integration instead of SOAP (QCRQ1I67601)

Problem:After integration, some APM actions fail

Solution:Operations Orchestration (OO)must be version 10.51 or higher

Reports and Reporting
PDF: It is not possible to search charts inside reports exported to PDF (since the charts are saved as
images). It is possible to search inside tables.

Export: It is not possible to export chart reports to Excel and XML (CSV is supported).

Scheduled reports do not get sent (QCCR1I66606)

Description: Favorite reports sent using the report scheduler or via Send Now mechanism do not
arrive to recipient email addresses.

Workaround: Ensure that theSMTP sender name setting uses email format. SMTP sender name is
set during installation or in APM from Admin > Platform > Setup and Maintenance > Infrastructure
Settings > Scheduled Reports.

APM/User Reports - Images referenced in the header/footer (pointing to a URL in the Internet)
are lost when exporting the report to PDF (QCCR1I89512)

Description: Images referenced in the header/footer are lost when exporting the report(s) to PDF. An
"X" is shown instead.

Workaround:Place the image(s) on the APMGateway Server under:
<APM installation folder>\AppServer\webapps\site.war\images
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Access the image in the header/footer as follows: <img src="http://<APM GW>/topaz/images/<image
name>" />

Application Health
Unable to load more than 200 business applications in Application Health (QCCR1I127523)

Description: If you havemore than 200 business applications in the Application Health Dashboard,
youmay experience slow loading of this page. The time will vary according to the specific machine
memory and CPU power.

Youmay also get an ‘undefined’ error message when waiting for the dashboard to load.

Recommendation: As a solution, we recommend that you:

l Limit the user permissions to view up to 200 applications. For information, seeApplication Health
Permissions in the APM User Guide.

l Create a dashboard filter that will limit the number of applications to 200. For information, see
Viewing the Application Health Dashboard in the APMUser Guide.

Service Health

Administration
The Rules API enables you to create new business rules for Service Health and Service Level
Management, using the Groovy scripting language. The APM documentation contains basic examples
of API rules. For additional examples of rules based on customer requests, see Software Support:
https://softwaresupport.softwaregrp.com/km/KM778069

Changing the breakdown configuration does not refresh Service Health components
(QCCR1I46143)

Description: In the BreakdownUI, changing the breakdown configuration does not refresh Service
Health components.

Workaround: If you have configured a breakdown in a local impact view (for example, transaction by
location), and you want to change the breakdown type (for example, to location by transaction), you
must perform the following steps:

1. Edit the original breakdown configuration, and select the new breakdown type as None.

2. Save the change, and wait a few minutes for the change to take effect.
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3. Select your view, and edit the breakdown type to the type you want defined.

Changes made to triplets not reflected in Service Health calculation (QCCR1I59377F)

Description: If youmake changes to the triplets that define impact links withinRTSM CI Type
Manager > Calculated Relationships > Triplets, these changes are not reflected in Service Health
calculation.

Workaround: After making these changes, access the JMX console (http://<server
name>:21212/jmx-console). Within theUCMDB list of services, select TQL Services, and invoke
retrieveTqlNames using your customer ID. Within the results, search formarble_dashboard_tql, and
click Deactivate. When deactivation is done, click Activate. Service Health calculations will now
implement your modified impact links.

Hidden rule parameters lose their default values (QCCR1I65242)

Description: If you create a KPI assignment that uses a rule with hidden rule parameters, and the
assignment updates an existing KPI with a different rule, the hidden rule parameters lose their default
values. This typically impacts rule calculations. (Note that this does not apply to new KPIs, but only to
existing KPIs which had a different rule before they were updated by the assignment.)

Workaround: Before updating the assignment, edit the rule definition in the Rule Repository andmake
the hidden rule parameters configurable (not hidden). You can then update the rule in the KPI
assignment, and synch existing CIs. After you save the assignment, you can return the rule
parameters to be hidden. Alternatively, you can delete the existing KPIs before running the KPI
assignment; this causes the assignment to create the KPIs rather than update them.

Cannot create local impact pattern view based on the BSMDowntime_impact query
(QCCR1I65385)

Description:WithinService Health Administration > View Builder, you cannot create a local
impact pattern view based on theBSMDowntime_impact query.

Workaround: You can create a pattern view based on theBSMDowntime_impact query within
RTSM Administration > Modeling Studio.

Application
TheWatch List component in Service Health does not support breakdowns; you cannot add virtual CIs
(breakdownCIs) from a local impact view to a watch list.
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PNR KPI Persistency: The PNR KPI in Service Health does not have persistency in case of a Data
Processing Server failure or a system restart. The PNR KPI shows an initialized status until the SLA is
recalculated, at which time the PNR value is updated.

Daylight Savings Time:

l Reports that include the time period during which a Daylight Savings Time (DST) change took place
(change to or change from DST) will either bemissing one hour (in cases where clocks aremoved
forward) or have two sets of data for the same hour (in cases where clocks aremoved back).

l If a report’s time range includes the time of a Daylight Savings Time (DST) change, the data for the
period after the DST time change is incorrect. To obtain correct data for the entire time range, print
two separate reports, one for the time range before the DST time change and one for the time range
after the DST time change.

Moving the Configuration Items dialog box can freeze the UI (QCCR1I42825)

Description:Within the 360° View, if you select the Filter icon on the toolbar, and then click the
Configuration Items link, the Configuration Items dialog box opens. If youmove this dialog box within
the screen, the UI can freeze.

Workaround: Reselect the component to enable it again.

If the management database goes down, the 360° View suffers a fatal error (QCCR1I46512)

Description: If you are working with High Availability and a load balancer, if themanagement database
goes down, the 360° View suffers a fatal error.

Workaround: Log out of APM and then log in again.

Inconsistency displaying breakdown views (QCCR1I47502)

Description: If no new samples were received after a breakdownwas defined in a view, and samples
were received from only some of the locations, the view can show inconsistent worst statuses on the
locations.

Workaround: None.

Not possibile to reset HI to default (QCCR1I48559)

Description: In the Health Indicators component, themenu command "Reset Health Indicator" to
reset an HI to its default state does not work for metric-based indicators.

Workaround: None.

Only one filter is saved in session per user and customer (QCCR1I52699)
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Description:Within the Hierarchy component, only one filter can be used at a time, per user, per
customer (regardless of quick filter or advanced). This means that if a user is using a filter in one
Hierarchy component, and the user then activates a different filter in another Hierarchy component, the
first filter is overridden.

Workaround: None.

Filter change done during Web Server or Application Server restart is not saved
(QCCR1I62605)

Description: If you are working in a high availability environment with a load balancer, and are editing
an existing filter in Service Health when the web server or application server restarts, changes to the
filter are not saved.

Workaround:None.

MyBSM
JavaScript errors when navigating from MyBSM (QCCR1I47291)

Description: In some versions of Internet Explorer if the browser is configured to show JavaScript
errors, when you navigate fromMyBSM to a different application in APM, a popup window appears.
This window contains the followingmessage: Errors on this webpage might cause it to work
incorrectly.

This message is not indicative of a problem. Any changes youmade inMyBSM are saved, and
MyBSM continues to work correctly.

Workaround: To prevent this message from appearing, within Internet Explorer access the Internet
Options > Advanced tab, and clear theDisplay a notification about every script error check box.

Performance issues when dragging Component Gallery pop-up in MyBSM (QCCR1I92585)

Description: Performance issues when dragging Component Gallery pop-up inMyBSM. Sometime
focus can be lost and user is forced to regain focus on the pop-up to continue dragging.

Workaround:None.

Service Level Management
The Rules API enables you to create new business rules for Service Health and Service Level
Management, using the Groovy scripting language. The APM documentation contains basic examples
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of API rules. For additional examples of rules based on customer requests, see Software Support:
https://softwaresupport.softwaregrp.com/km/KM778069

PNR KPIs: In Service Level Management, you cannot attachmore than one PNR KPI (defined in
Service Health) to a CI.

CIs in SLAs:You cannot add a CI to an SLA when the CI includes a copy of itself in the original
definition in the RTSM. This is because nesting is meaningless in the SLA calculation (Service Level
Management cannot calculate a CI using the CI result as a value). If you do so, your operation will fail
with a general error. However, you can add the sameCI to an SLA more than once if the CI does not
include a descendant of itself. In this case, Service Level Management calculates the CI only once, so
the objectives are the same nomatter where the CI appears in the SLA hierarchy.

Linkage between Business Transaction and SAP Transaction is disabled (QCCR1I47274)

Description: After APM restart, the automatic linkage of Business Transactions to SAP Transactions
is disabled.

Workaround: To enable the linkagemechanism, restart the VERTICALS service in theMercuryAS
process.

End User Management
Error in Alerts tab in End User Management (EUM) Administration when using Java 7u9 plug-
in (QCCR1I79407)

Description:An error may occur when clicking the Alerts tab in EUM Admin if client browser is using
Java 7u9 plug-in.

Workaround:Clean Java browser cache and then open the Alerts tab again. To clean the Java cache:

1. Navigate toStart > Control Panel > Java.

2. In the Temporary Internet Files section, click Settings.

3. In the Temporary File Settings dialog box, click Delete Files.

Business Process Monitor
VuGen Scripts:When you run a script written in VuGen that uses proxy settings from an automatic
configuration script (.pac file) configured in the runtime settings of the script, if one of the proxies in the
.pac file is unavailable, replaying the script in either VuGen or Business Process Monitor may result in a
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high response time and, in some instances, the script may fail due to a timeout. The script can be run in
Internet Explorer without this problem, as it ignores the unavailable proxy.

Page Component Breakdown URL:When running a page component breakdown (from EndUser
Management or Business Process Monitor), the target URL is limited to 144 characters.

Real User Monitor
Some active filters do not work on upgraded RUM data (QCCR1I62276)

Description:When reports are generated for RUM data that has been upgraded to version 9.x, some of
the active filters in the report do not work.

Workaround: None.

RUM reports not available (QCCR1I63076)

Description:RUM reports are not available in APM .

Workaround: If you configure an application for RUM in the APM UI (Application > End User
Management) the first time you log in to a new APM system, log out of APM and log in again before
accessing RUM reports.

RUM Admin - disable back-end tiers discovery in Generic protocols (QCCR1I64131)

Description: In EUM Administration, automatic tier discovery does not work for the following generic
protocols, even if the Enable automatic tier discovery check box is selected:

l TCP Request-Response

l TCP Streaming

l UDP Request-Response

l UDP Streaming

Workaround:None.

Failed to create RUM action when using more than 87 Asian characters in name or 166 in
description (QCCR1I89760)

Description:When creating a new RUM action/page in APM and using Asian characters, you are
limited to nomore than 87 characters for the name and 166 characters for the description.

Workaround:None.

Client Monitor Probe should be able to capture and report 4xx and 5xx error events
(QCCR1I111139)
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Description:Client Monitor Probe does not report HTTP error events, such as 400 series error (page
not found, etc.) and 500 series error (server errors)

Workaround: None.

System Availability Management and
SiteScope
SiteScope Release Notes:Refer to the SiteScope release notes for all SiteScope limitations.

SiteScope Documentation: SiteScope documentation is available only as a standalone help
system. It is not a part of APM Help.
You can access the SiteScope documentation online at
https://docs.microfocus.com/itom/SiteScope:2018.05/Home or access the .pdf files supplied with
SiteScope.

SAM Administration Copy and Paste: In System Availability Management Administration, when
copying objects from one SiteScope to another, there is no dependency check. This means that you
can copy an object that depends on another object to a different SiteScope, even though the object on
which it depends does not exist on the target SiteScope.

SAM Administration Page cannot be displayed error: In System Availability Management
Administration, when the SiteScope service is down, instead of receiving an error to this effect, you will
see aPage cannot be displayed error.

SiteScope Reset: If a SiteScope is being reset when APM is not running, the SiteScope will appear as
registered with a configurable profile in System Availability Management Administration once APM is
running again. The SiteScopemust be reset when APM is running.

SAM Administration Recently Used Monitors:On theNew Monitor page, theRecently Used
Monitors list is not saved when you exit System Availability Management Administration.

SiteScope Profiles:When creating a SiteScope profile in System Availability Management
Administration, if you change the profile display name after having received any error during the profile
creation process, the default profile name is not changed accordingly. Ensure that the profile name and
SiteScope agent machine location fields contain the desired values.

Monitor Deployment Wizard only supports topology reporting for monitors that have a default
topology defined (QCCR1I39697)
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Description: TheMonitor Deployment Wizard only supports topology reporting for monitors that have
a default topology defined. This means you can select to add a template to a CI only if the CI type is the
default CI type for all themonitors in the template.

Workaround: None.

After JBoss Application Server recovery, there is no data in SAM Administration "Summary"
(QCCR1I44570)

Description: After JBoss Application Server recovers from a server crash, the information in the right
pane of the Summary tab in SAM Administration does not show any data until APM is restarted.

Workaround: Restart APM.

408 Request Timeout error in Internet Explorer 7

Description:When accessing SiteScope from System Availability Management Administration using
Internet Explorer 7, a 408 Request Timeout error is displayed.

Workaround: Configure the browser to accept cookies from the SiteScope server.

1. In Internet Explorer, select Tools > Internet Options > Privacy tab > Advanced button.

2. Select Override automatic cookie handling, make sure First-party cookies and Third-party
cookies are set toAccept, and select Always allow session cookies.

Settings when registering SiteScope to a APM server that uses a load balancer (QCCR1I56354)

Description:When registering SiteScope to a APM server that uses a load balancer, make sure that
the Gateway server name/IP address (inAdmin > System Availability Management > Distributed
Settings) is the Default Virtual Server for Application Users URL (and not the Default Virtual Server for
Data Collectors URL). This URL can be found inAdmin > Platform > Setup and Maintenance >
Infrastructure Settings > Foundations > Platform Administration > Host Configuration table.

Workaround: None.

No reconciliation between SiteScope and Discovery and Dependency Mapping (QCCR1I56709)

Description: There is no reconciliation between SiteScope and Discovery and Dependency Mapping
when there is only a default SQL server instance. SiteScope reports the default value "SQLServer" as
the name of the CI, while DDM reports the name of the host.

Workaround: Install an SQL database with a named instance.

Unable to perform some actions in SAM Administration in a load balancing environment
(QCCR1I58582)
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Description: Unable to perform the following actions in SAM Administration in a load balancing
environment when SiteScope 10.x or later is integrated with APM:

l Copy/paste from one SiteScope to another.

l Perform aGlobal Search and Replace.

l Run theMonitor Deployment Wizard.

Workaround: Register (or remove and reregister) SiteScope to the APM server using the Default
Virtual Server for Application Users URL instead of the Default Virtual Server for Data Collectors URL
(enter the URL inAdmin > System Availability Management > Distributed Settings > Gateway
server name/IP address). This URL can be found inAdmin > Platform > Setup and Maintenance
> Infrastructure Settings > Foundations > Platform Administration > Host Configuration table.

If you cannot remove SiteScope from APM because you do not want to lose data, you can change the
host name on SiteScope under APM Integration Preferences (Preferences > Integration Preferences
> Application Performance Management machine name/IP address).

SISConfigurationEnrichmentUpgrader failure (QCCR1I65694)

Description:During APM upgrade, SISConfigurationEnrichmentUpgrader may report FAILED,
PARTIALLY FAILED, or NOT REQUIRED status, or the APM content packs may not automatically
upload.

Workaround: Delete the blockAutoUpload file located in the <APM root
directory>\conf\opr\content folder.

Run-time Service Model (RTSM)

Installation and Upgrade
You can manually update the MySQL version on the installed Data Flow Probe. This is an
optional procedure for customers who prefer to use the latest MySQL version, and is not
mandatory for an operational probe.

To update theMySQL version on the Data Flow Probe:

1. Log into themachine where the Data Flow Probe is running.

2. Stop the Data Flow Probe (either using a console or theUCMDB Probe service).

3. Stop theMySQL service by opening theServices console and locating theUCMDB_Probe_DB
service.

4. Locate theMySQL installation (for example, C:\hp\UCMDB\DataFlowProbe\MySQL).

5. Rename theMySQL directory to a different name. This step is for backup purposes only.
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6. Copy theMySQL.zip file containing the new version to the Data Flow Probemachine and extract
it under the DataFlowProbe directory so that a new MySQL directory is created under it (for
example C:\HP\UCMDB\DataFlowProbe\MySQL directory).

7. Edit theMySQL\my.ini configuration file to contain the correct paths.

For example, if DataFlowProbe is installed under C:\HP\UCMDB\DataFlowProbe directory,
updatemy.ini to contain the following lines:

# TheMySQL server

[mysqld]

basedir = "C:/hp/UCMDB/DataFlowProbe//MySQL/"

datadir = "C:/hp/UCMDB/DataFlowProbe//MySQL/data/"

tmpdir = "C:/hp/UCMDB/DataFlowProbe//MySQL/temp/"

8. Start theMySQL service.

9. Run the clearProbeData.bat script (for example
C:\HP\UCMDB\DataFlowProbe\tools\clearProbeData.bat).

10. Start the Data Flow Probe.

All UCMDB help pages throw an error when you try to access them from the APM application. You can
access the UCMDB help pages using the following link:
http://cmshelpcenter.saas.hp.com/CMS/Content/Index.htm

Unsupported UCMDB version error messages appear in the log file (HTMLDocument) located in
<HPE APM root directory>\odb\runtime\log\package_reports\customer_1\deployReports\
relating to theCMKpiAdapter.zip andCMPolicyAdapter.zip packages. You can ignore these error
messages since the packages, which are part of the Content Pack (CP), are not required for APM
functionality.

After upgrading a client machine to Java 7 updates 2 or 3, text fields in dialog boxes are not in focus and
the user shouldmanually click on the fields to bring them into focus. This limitation can occur when
using the Internet Explorer and Firefox browsers; it does not occur when using the Google Chrome
browser.

When the Data Flow Probe is configured to be installed in separatemode, so that Manager and
Gateway processes are running on separatemachines, the following additional configuration is required
on the Discovery Flow ProbeManager's machine:

1. The ProbeManager must have the exact same Probe ID (appilog.collectors.probe.name) as
specified during the installation of the ProbeGateway.
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2. Stop theManager process (if it is already running).

3. Open <UCMDB installation>\ DataFlowProbe\conf\DiscoveryProbe.properties and locate
the following code:

# The Domain name

appilog.collectors.domain = ${DefaultDomain}

4. Change this code to contain the Data Flow Probe's actual domain. For the default domain,
DefaultDomain, this code should look as follows:

# The Domain name

appilog.collectors.domain = DefaultDomain

5. Save DiscoveryProbe.properties and start theManager process.

After upgrading to the latest APM patch, if a job's time zone setting was other than "Discovery probe
time zone", it must be reconfigured to the correct time zone.

When upgrading from BSM versions 9.26 or earlier, if you enabled Update/View permissions in the
Data Flow Management modules, but did not enable the Execute permission, youmust manually re-
enable thosemodules by selecting the Execute/Update permission for the relevant users. For the
Adapter Management, the permission should be set toUpdate.

If integrations are configured under RTSM Integration Studio (for example, topology synchronization
integrations between central UCMDB and RTSM), after upgrading, the Data Flow Probe will run
population jobs immediately for active integration points, even if the integration is not scheduled. If you
do not want the integration to run, disable the integration before running the upgrade from any BSM 9.x
version.

Application and Modeling
Hidden queries are no longer displayed in PackageManager by default. To display hidden queries in
PackageManager, go to User Preferences and change the value of the Show hidden queries in the
Modeling Studio user preference to true.

If a TQL query containing a federated history query node fails to calculate when using the Changed
during x hours operator, redeploy the CmdbHistoryAdapter located in the ..\<Data Processing Server
root directory>\odb\content\adapters directory.

The APM server may not start up properly when the settingMax CIs in view supported to
rediscover in the Infrastructure Settings Manager is set to very high values.
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When creating a cron expression in the Job Definition Scheduler, the time and datemust be in the
future. If the current date or a past date is defined, it will cause an error.

When Delete permission is assigned for a CIT, all of its sub-classes can also be deleted.

When Create permission is assigned for a CIT, it can be updated and all of its sub-classes can also be
created.

In Enrichment Manager, Impact Analysis Manager, and CIT Manager, when you select several CITs
and their connecting relationships and select Export Map to Imagewith theSelected Object Only
option, the resulting image does not display the relationship names.

It is possible to edit CITs even if they are assigned the READ_ONLY_CLASS qualifier.

The Screen Capture tool cannot capture a screen shot when the UCMDB/RTSM browser is running in
amulti-display environment.

TheClear Filter button in the Job List dialog box (for scheduled reports and scheduled snapshots)
does not work properly.

When creating a new Impact rule in the Impact Analysis Manager, the created Impact rule can be run
within the IT UniverseManager even if theUCMDB check box on the Impact Rule Groups page of the
wizard is not selected.

In IT Universe, if you right-click a Virtual Compound Link from theGet Related pane, the Show
Compound Path option is disabled.

The following API has been added to the CI Selector to get the selected CIs' display labels and class
names using Javascript:

l String getSelectedCmdbObjectDisplayNames()
l String getSelectedCmdbObjectClassNames()

The new retrieveAllActiveUsers()method is now available in theUCMDB-UI:name=UCMDB
Integration section of the JMX console. This is equivalent to the getAllActiveUsers()method that
was available in UCMDB version 8.0x.

In the UCMDB_JavaAPI, in cases where an attribute type was of type string or integer list, the
Attribute#getDefaultValue()method, which had returned strings in XML format, now returns a
collection of string or integer objects.
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There have been some performance improvements in the Generic Database Adapter.

In theViews tab in the Security Manager, when Delete permission is set and a view is deleted, the
query on which the view depends is also deleted.

When working in multi-customer environment (such as SaaS), youmust work with a single database
and schema.

In theModeling Studio, it is not possible to createmore than one pattern-basedmodel of the sameCI
type, based on the same query. When you try to create a new one, it overwrites the existing one.

Deprecated CI types do not appear in strike through font if the font size is less than 14 points.

In the Routing tab in the Layout Properties dialog box, (accessed by selecting Layout > Layout
Properties), all the options seem to be available, but only some of them are actually used in the layout
of themap.

In the Impact Analysis Manager, if an XML file is imported with the same file name as an existing
Impact Rule, a confirmationmessage saying that an Impact Rule of that name already exists is not
displayed before replacing the existing Impact rule.

When exporting CI instances found for a selected TQL, you can now manually enter up to 150,000 CIs
per page.

If you haveDelete permissions for views and you delete a view, the TQL query on which the view
depends is also deleted.

In theModeling Studio, no informative error message is displayed when you import an invalid XML file
for views or queries.

In Modeling Studio, you cannot change the query type of an Enrichment or Impact Analysis query in the
Query Definition Properties dialog box if there are resources that are defined on top of this query.

In the Impact Analysis manager, when you try to save an Impact rule for which you defined a sub-
graph, a generic error message appears without giving detailed information regarding the problem.

Printing semi-transparent graphics using theRun Screen Capture Tool produces poor quality results.
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In the Hierarchical tab in the Layout Properties dialog box, (accessed by selecting Layout > Layout
Properties), theMinimum Backward Edges andOptimize For Feedback Flow options do not work
properly.

The new viewing system currently does not support displaying view results via the IT Universe
Manager that were based on a rule-based template.

When displaying CIT instances with the network port number property, the network port number is
displayed with a comma. This comma is irrelevant but is displayed because of themanner in which
Java reads the value from the system.

When you search for a string in theModeling Studio or the Reports module, the Highlight button
highlights only the first occurrence of the string that is found.

When a calculated relationship is selected in Enrichment Manager or Impact Analysis Manager, the
Qualifier tab in the Relationship Properties dialog box is not functional (the qualifiers selected are not
applied to the selected relationship).

When creating a view based on a new TQL query in Modeling Studio, if you add a condition to one of the
query nodes and save the view, and thenmodify the view topology without closing the window, an error
is generated. To avoid the error, close the window after adding the condition and saving the view, and
then open the view again andmake the topology changes.

The Show Element Instances dialog box does not display the External icon for federated CIs.

The Hierarchy Pane of the Pattern View Editor in Modeling Studio does not display the External icon for
federated CITs in the TQL query.

When editing an out-of-the-box attribute of type byte, an error is generated. For example, when editing
the AttachementContent attribute of an Attachment CI, an error occurs. User-created attributes can be
edited safely.

You can set the starting date and time and repeat interval for pattern-basedmodel updates using the
Pattern BasedModel Scheduler dialog box in theModeling Studio. Select Daily Pattern BasedModel
Scheduler Updates to set the repeat interval in hours. Select Advanced Pattern BasedModel
Scheduler Updates to set the repeat interval using a cron expression.

A fatal error occurs when clicking the Run Screen Capture Tool icon under RTSM administration
(QCCR1I123769)
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Confidential Manager
If you change the default domain name in RTSM, youmust first verify that the Data Flow Probe is not
running. After the default domain name is applied, youmust execute the
DataFlowProbe\tools\clearProbeData.bat script on the Data Flow Probe side, and then restart the
Data Flow Probe.

Note:Execution of the clearProbeData.bat script will cause a discovery cycle on the Probe side once
the Probe is up.

Discovery
When setting up the Data Flow Probe, if you import illegal ranges from aCSV file (for example, the start
IP is higher than the end IP), no error is displayed, and the range is saved. Youmust fix the invalid
rangemanually.

SQL Protocol: The EncryptionMethod field enables you to choose SSL support for Oracle
connections.

SNMP Protocol: ThePrivacy Algorithm now supports both DES and AES algorithms.

If you want to connect a new Data Flow Probe to RTSMwith an identifier of a Data Flow Probe that is
already defined on a different domain, youmust remove the existing Probe from RTSM (from the Data
Flow Probe Setupmodule), prior to installing the new Probe.

To prevent an overload on the Data Flow Probemachine, you can limit the number of remote processes
that run simultaneously. Locate the appilog.agent.local.services.maxRemoteProcesses parameter
in theDiscoveryProbe.properties file. The default value is unlimited (-1). Change the value to the
maximum number of processes that can be run simultaneously. If you change this value, youmust
restart the Probe. (This overload can occur when activating certain out-of-the-box jobs that launch a
Java process for each destination, for example, J2EE or SAP jobs.)

Downloaded jar file resources can cause the Probe to restart before all the other resources of an
adapter package have downloaded. To prevent this occurring, the reset time is, by default, 40minutes.
You can change this time:
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Access the appilog.agent.probe.restartProbeAfterJarDownload.interval parameter in the
DiscoveryProbe.properties file. The delay until a restart on the first resource download (that is, for a
first start or after clearing the Probe data) is 10milliseconds.

In the Dependency Map, when selecting to show all instances of a selected CI, the instances are not
displayed.

When you try to filter triggered CIs by probe in the Discovery Control Panel - Status pane, the triggered
CIs are not filtered.

Discovery job error and warningmessages are displayed in the language of your client's operating
system, independent of browser language settings.

Integration
It is now possible to disable the reporting of null values in the GDBA adapter by adding in the adapter's
adapter.conf file the following setting: report.null.values=false.

Integration job for syncing (population syncing) between RTSM and CMS is limited to 500,000
CIs and relationships (QCCR1I79192)

Description: The integration job that is defined to sync (population sync) between the RTSM andCMS
(or another instance of RTSM) and vice versa, is limited to 500,000 CIs and relationships. This is a
limitation of live TQL queries. This limitation applies to all sync jobs that pull data simultaneously from
the sameCMS/RTSM – they are restricted to a total of 500,000 CIs and relationships.

When syncing data from UCMDB/CMS 10.01 CUP 5 and up to RTSM, it is recommended to use the
push sync adapter on the CMS side instead of population. This sync method is limited to 5million CIs
and relationships per sync job.

If you are using data synchronization between APM and the central CMDB or OMI's RTSMwith aging
enabled in the adapter, if you disable the sync for a time period which exceeds the aging interval, CIs
may be deleted by the agingmechanism. As a result, related data and configurations in APMmay be
lost as well.

Workaround: If you plan to stop data synchronization between APM and the central CMDB for a time
period which exceeds the aging interval, it is recommended to disable the aging in the adapter. If the
aging has been enabled and is changed to be disabled, it is recommended to run full data
synchronization before stopping the data synchronization between APM and the central CMDB.
(QCCR1H65590)
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When running a history-based push job (for changes), you can incorrectly select any integration TQL
query, even those that are federated or contain virtual links.

If you start a population job (for the first time) on a TQL query that is currently being edited, saving the
query may remove its "Active" status and cause the job to fail. If this occurs, running a full population
job again will fix the problem.

A population job that uses the UCMDB 9.x adapter to retrieve federated data can retrieve only added or
updated CIs, but cannot remove deleted CIs from the CMDB.

The EMC Control Center (ECC) database does not containWWN (WorldWide Name) information for
FCHBAs (Fiber Channel Host Bus Adapters) attached to Storage Arrays. Therefore, this discovery
populates theWWN attribute of FCHBA CIs with the ECC ID (internal to ECC) of the HBA. The script
also populates the data_note attribute of each such FCHBA CI with a note that ECC does not have
WWN info and duplication of this CI is possible.

Discovery and Integration Content
For details on the Discovery and Integration Content Pack versions compatible with this version of
APM, see the APM System Requirements and Support Matrixes Guide associated with the version of
APM you are installing.

Child CIs are no longer included in reconciliation rules when considering identification for Business
Applications. An optional identifier based on the ID (App_ID) can be used to uniquely identify each
Business Application CI. Business Applications that are synced from external sources must have a
unique name or ID in order to be included during data synchronization. Note that multiple Business
Applications with the same name and no ID will not be synchronized.

Additional CI types for which child CIs are no longer included in reconciliation rules are Business
Process, Business Service, CI Collection, Business Transaction Flow, and Dynamic NodeGroup. No
optional identifier can be specified for these CI types.

Content Pack Documentation Updates

To read the latest versions of the relevant documents, access the following URLs:

l <http://SERVER_NAME:PORT/ucmdb-ui>/docs/DDMContent.jsp – Discovery and Integration
Content Guide

l <http://SERVER_NAME:PORT/ucmdb-ui>/docs/permissions.jsp – the Permissions document
l <http://SERVER_NAME:PORT/ucmdb-ui>/docs/readme.jsp – the Release Notes (this file)
l <http://SERVER_NAME:PORT/ucmdb-ui>/docs/whatsnew.jsp –What's New in this release

Release Notes
Notes and Limitations

Application Performance
Management (9.50)

Page 38 of 45



RTSMMultilingual Support
Multi-Byte characters do not appear in titles and sub-titles in reports when exporting or previewing as
PDF.

For reasons of compatibility, Integration Point names and Data Flow Management job names can
include only English letters, numbers, and the underscore character (_).

Because themaximum string length for many UCMDB parameters is defined and documented in
bytes, the real acceptable value length is shorter whenmulti-byte or language-specific characters are
used.

In Enrichment Manager, required attributes in theNode Definition dialog box are not marked in bold for
the Japanese, Chinese, and Korean versions.

Non-English characters should not be used in paths to different properties or adapter files.

Multi-byte characters should not be used in user passwords.

The action names in scheduled jobs are stored with localized names (according to the locale being
used), but those names are displayed with no dependence on locale. Those action names may be user-
modified and therefore will be user-specific.

Excel can now open UTF-8 encoded CSV documents correctly.

Universal CMDB/RTSM does not fully support surrogate pairs and combining characters.

Diagnostics

Translated Versions

Diagnostics has been translated into a number of languages. When using Diagnostics, occasionally
text that should be translated will be shown in English. This is due to limitations in third party
components that are used by Diagnostics. We apologize for any inconvenience that this may cause.

When call/min values are very small, the graph is not displayed since the graph resolution is
too low. (QCCR1I127077)
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Description: The graph should support a higher resolution so it can reflect very small values as well.

Workaround:None.

Transaction’s call/min may have different values in transactions list (left pane) and transaction
summary (right pane) (QCCR1I126272)

Description: Transaction summary is refreshed when you select a transaction from the list while the
list is refreshed when you click theRefresh button. The values are refreshed in different points in time
and therefore can be different.

Workaround:Click theRefresh button to align the values.

Documentation
The note about accessing the JMX console from the localhost in the JMX Console chapter of the APM
Platform Administration Guide and the instructions inHow to Enable Accessing JMX Console
Remotely in this chapter only applies to JMX ports other than 8080 (for example, 21212). To secure
access to the JMX console through port 8080, see the instructions inOpening JBoss HTTP Port 8080
in theHardeningWorkflow chapter in the APMHardening Guide.

The section on Integrating Multiple CMDBs in theRTSM Data Flow Management Guide does not
contain support information for recent APM releases. For the complete APM-CMS support matrix, refer
to theAPM System Requirements and Support Matrixes pdf.

In the APMHelp, the previous and next buttons do not function for the Run-time ServiceModel (RTSM)
topics.

Multilingual Support

The left menus and other UI elements in Application Health are not translated to the language
of non-default locales (QCCR1I127010)

Description: In any browser, when the locale is set to a non-default locale, the left menus and other UI
elements in Application Health are not translated to the language of that locale.

Workaround: In your browser, change the selected language to be themain language of the selected
locale. For example, for German just select German [de] and not the one with additions such as
German (Germany )[de-DE].

For example, in Internet Explorer:
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1. Click the Tools button at the top-right of your browser window.

2. Click Internet Options.

3. In the General tab, under the Appearance heading, click Languages.

4. Select the two letter language code of the locale andmove it to the top of the language list.

5. Click OK.

NOTE:
This procedure is similar in all browsers.

Items in component gallery are not translated; Service Health top pane tabs (Page Names) are
not localized (QCCR1I69138, QCCR1I45575)

Unreadable characters in command line interface help (QCCR1A139904)

Description: There is a general problem with printing localized unicode text on theWindows command
line. Due to limitations in the default console font and the wrong code page being in place, certain
characters do not display correctly.

A detailed description of this problem can be found at :

http://illegalargumentexception.blogspot.com/2009/04/i18n-unicode-at-windows-
command-prompt.html#charsets_1252

Workaround: In the console window onWindows perform the following actions:

1. Open the properties of the commandwindow (right-click on the frame and select Properties.
Switch to the Font tab and change the font to Lucida Console.

2. Click theOK button to close the properties dialog box. The new font setting is used for all future
command prompts.

3. In a commandwindow, enter the following command:

chcp 1252

All command line tools should now display with the correct localized text.

Application > Service Health top pane tabs (Page Names) are not localized (QCCR1I45575)

The RTSM Class Model does not support multi-byte character sets. All class model items,
including CI type, relationship, and attribute names, descriptions, and display labels, cannot
contain multi-byte characters. (QCCR1I62755)
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SiteScope
(QCCR1I130279) During SiteScope installation on Linux, there is an additional Uninstall folder
that is created outside the SiteScope directory (/opt/HP/Uninstall). This has no impact on the
SiteScope installation or uninstallation. However, do not delete this folder as this will result in
uninstallation failure.
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Fixed Issues
This section lists fixed problems and limitations for APM 9.50 that have beenmade visible to
customers for tracking in the Software Support web site (https://softwaresupport.softwaregrp.com/).

For a complete list of the problems and limitations fixed in this release that have beenmade visible to
customers for tracking:

1. Navigate to the Self-Solve Knowledge Search page, on the Software Support web site
(https://softwaresupport.softwaregrp.com/).

2. Select the relevant product, version , and operating system (for example, Application
Performance Management (BAC > 9.50 > Windows).

3. Under Document Type, select known problems.

4. Click the issue that you want to view (or download). A page containing information about the issue
displays.

Unable to create Enrichment rule based on new query (QCCR1I119184)

Symptom:

Unable to save an Enrichment rule when it is based on a new query .

Resolution:

You are now able to save an Enrichment rule when it is based on a new query .

APM does not start with manually created schemas on Oracle (QCCR1I119376)

Symptom:

APM does not start with shemas that weremanually created in Oracle.

Resolution:

APM now starts with shemas that weremanually created in Oracle.

APM 9.40 RTSM: OOTB Integration Point RTSM to RTSM could not authenticate on remote
target (QCCR1H117059)
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Symptom:

OOTB Integration Point RTSM to RTSM could not authenticate on remote target the same credentials
works with BSM 9.x adapter.

Resolution:

Apply the Hotfix implemented in QCCR1H117059 for APM 9.30 release.

Enhancement Requests
Issue
ID

Summary

119920 BSM 9.26 IP1 - Change in the name of the pdf custom report for month

129206 Before restart/shutdown of BSM processes, automated way of checking if pmanager is in
sleepmode.
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Send documentation feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on Release Notes (Micro Focus Application Performance Management 9.50)

Add your feedback to the email and click Send.

If no email client is available, copy the information above to a new message in a webmail client, and
send your feedback to docs.feedback@microfocus.com.

We appreciate your feedback!

Release Notes
Send documentation feedback

Application Performance
Management (9.50)

Page 45 of 45

mailto:docs.feedback@microfocus.com?subject=Feedback on Release Notes (Micro Focus Application Performance
Management 9.50)

	Application Performance Management Release Notes
	What's New in This Release
	APM Support Matrixes

	Installation Instructions
	Updated Components
	Fixed Customer Encountered Defects
	Fixed in APM 9.50
	Fixed in BPM 9.50
	Fixed in RUM 9.50
	Fixed in SIS 2018.05
	Fixed in Diag 9.50

	Notes and Limitations
	General and Deployment
	Platform
	Integrations
	Reports and Reporting
	Application Health
	Service Health
	Administration
	Application

	MyBSM
	Service Level Management
	End User Management
	Business Process Monitor
	Real User Monitor

	System Availability Management and SiteScope
	Run-time Service Model (RTSM)
	Installation and Upgrade
	Application and Modeling
	Confidential Manager
	Discovery
	Integration
	Discovery and Integration Content
	RTSM Multilingual Support

	Diagnostics
	Documentation
	Multilingual Support
	SiteScope


	Fixed Issues
	Enhancement Requests

	Send documentation feedback

